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1 Main Index

  Fractal Lab Help Index

If you need additional help with any of the  topics below, click on the underlined keyword. 

Getting Started

Fractal Lab Remote

  Commands
File menu
Edit menu
Image menu
Flags menu
View menu
Window menu
Audio/Video menu
Demo menu
Help menu

1.1 Title Bar

Title Bar

The title bar is located along the top of a window.  It contains the name of the application and
drawing.

To move the window, drag the title bar.  Note: You can also move dialog boxes by dragging their
title bars.

A title bar may contain the following elements:
Application Control-menu button
Drawing Control-menu button
Maximize button
Minimize button
Name of the application
Name of the drawing
Restore button

1.2 Scroll Bars

 Scroll bars

Displayed at the right and bottom edges of the drawing window.  The scroll boxes inside the scroll
bars indicate your vertical and horizontal location in the drawing.  You can use the mouse to scroll to
other parts of the drawing.
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1.3 Size

Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow
keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to

the border you want to move.  
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:  This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.

1.4 Move

Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog
box with the arrow keys.

Note:  This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7

1.5 Minimize Command

Minimize command (application Control menu)

Use this command to reduce the Fractal Lab window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9
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1.6 Maximize Command

Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a drawing window.

1.7 Next Window

Next Window command (drawing Control menu)

Use this command to switch to the next open drawing window.  Fractal Lab determines which
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6

1.8 Previous Window

Previous Window command (drawing Control menu)

Use this command to switch to the previous open drawing window.  Fractal Lab determines which
window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6

1.9 Close

Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: CTRL+F4 closes a drawing window

ALT+F4 closes the application
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1.10 Restore

Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the
Maximize or Minimize command.

1.11 Switch to

Switch to command (application Control menu)

Use this command to display a list of all open applications.  Use this "Task List" to switch to or close
an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.  This option does not
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.  This option does not affect
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.
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2 Fractal Lab Remote

    Fractal Lab Remote

The remote provides access to many of the most-used commands in Fractal Lab.  Information about
each button can be obtained by using the '?' located near the close box in the top right-hand corner
of the remote.

2.1 New button

   New button

Use this button to create a new draw window in Fractal Lab.  The default parameters for the new
window will be the same as the startup drawing.

2.2 Undo button

   Undo button

Use this command to undo the last action.  Color-cycling is disabled after using Undo.

2.3 Size button

    Size button

This allows you to set the drawing area for a picture, independent of the Windows screen size.  It
also shows which size is currently in use.  The aspect for the drawing is based on the ratio of X
(horizontal width) to Y (vertical height.)  The custom setting allows for any size/aspect that system
memory will permit.  The minimum size for an image is 60X30.  Note: the aspect of the figure is
always 1/1 regardless of the draw window's aspect.

2.4 Color button

    Color button

Use the palette editor to modify the color palette.  Note: one palette of 236 colors is used for all
figures in a composite fractal, but the each segment in a generator may be a different color.

2.5 Text button

   Text button

Use this button to add text to the active drawing.
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2.6 View button

    View button

Displays the entire plot, expanding or shrinking the image to fit in a maximized window without title
bar, scroll bars or menu bar.  At all other times, part of the picture may be hidden by the inclusion of
the title bar, toolbar, scroll bars and menu bar.  To exit full-screen mode, press any key or click the
left-mouse button.

2.7 Draw button

   Draw button

Use this button to draw or redraw the image for the current fractal variables.  "Draw" invokes the
Level window, then draws the current fractal at the specified level of recursion.  Clears the screen
before drawing (if autoclear is enabled).  Click the left-mouse button to stop a drawing in progress. 
Select Draw to draw a new fractal, with a new random factor if the RANDOMSIDES flag is set. 
Select Redraw to keep the current random factor.  Note: the current random factor may not
produce the same image pattern if the depth of the picture is changed.

2.8 Help button

    Help button

Use this button to open the help index for Fractal Lab.  

2.9 Generator button

   Generator button

Use this button to edit the current generator.

2.10 Initiator button

   Initiator button

Use this button to edit the current initiator. 

2.11 Scale

   Scale

Invokes the Scale window.  The Scale Window scales the initiator length and screen positions to
effectively reduce or expand the fractal image.  A scale of .5 affects both X and Y coordinates, so
the image is quartered.  A scale of 2.0 would make the image four times as large.  A range of .1 to
9.9 is allowed in the scale gadget, but the program checks that points do not exceed screen limits. 
A fractal may still attempt to draw itself off screen, and is then clipped.  Points that would end off the
screen are not drawn.
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2.12 Scale Composite

   Scale Composite

Invokes the Scale window to scale composite figures.  The Scale Window scales the initiator length
and screen positions to effectively reduce or expand the fractal image.  A scale of .5 affects both X
and Y coordinates, so the image is quartered.  A scale of 2.0 would make the image four times as
large.  A range of .1 to 9.9 is allowed in the scale gadget, but the program checks that points do not
exceed screen limits.  A fractal may still attempt to draw itself off screen, and is then clipped.  Points
that would end off the screen are not drawn.

2.13 Move

   Move

"Move" changes the cursor to a cross to relocate the fractal's starting point anywhere on the screen,
modifying the setting of the initiator  Click where you want the center of the fractal.  The starting
points of each initiator segment are adjusted to correspond with the shift in the first segment.  Useful
for tiling multiple fractals on the screen, or putting different fractals side by side.  Does not change
the random factor when the RANDOMSIDES flag is set.  This enables random dragons to be
moved.

2.14 Move Composite

   Move Composite

"Move Composite" changes the cursor to a cross to relocate the fractal's starting point anywhere on
the screen, modifying the setting of all the initiators in a composite fractal.  Click where you want the
center of the composite fractal.  The starting points of each initiator segment are adjusted to
correspond with the shift in the first segment.  Useful for tiling composite fractals on the screen, or
putting different fractals side by side.  Does not change the random factor when the
RANDOMSIDES flag is set.  This enables random dragons to be moved.

2.15 Center

   Center

Use this command to re-center the current figure.  Useful when you rotate a figure and it ends up off
center.

2.16 Center Composite

   Center Composite

Use this command to re-center all figures in the current composite figure.  Useful when you rotate a
figure and it ends up off center.  Note: each figure can have a different center point, so using this
command won't necessarily make all figures line up around the same center point.  Use Move
Composite to change the center point for all figures to the same point.
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2.17 Alternate

   Alternate

ALTERNATE tells the generate routine to reverse the side placement of the generator at each stage
of recursion.  Must be set to draw snowflakes, etc.  ALTERNATE excludes the RANDOMSIDES
and ALTFIRSTPOS flags and enables the RANDOMREVERSE flag to be set or not.

2.18 Random Reverse

   Random Reverse

RANDOMREVERSE reverses the generator without changing the side it is to be draw on.  Used to
create random snowflakes, etc.

2.19 Random Sides

   Random Sides

RANDOMSIDES randomizes the side the generator is placed on at the first stage of each level of
recursion after the first recursion.  Must be set to draw random dragons.  Excludes ALTERNATE,
ALTFIRSTPOS and disables the RANDOMREVERSE item.

2.20 AltFirstPos

   AltFirstPos

ALTFIRSTPOS alternates the generator every other level starting with the lowest level.  Excludes
ALTERNATE and RANDOMSIDES.  Used for the Polya fractal.

2.21 RevRightSide

   RevRightSide

REVRIGHTSIDE reverses the generator when it is drawn on the right side.  Used for the Peano-
Gosper fractal and Quartet fractal. Can be used with any of the other flags, for different effects.

2.22 No Flags

   No Flags

NO FLAGS excludes all other flags and disables RANDOMREVERSE.  Use to display the original
dragon curve, or to eliminate the random factor from any curve that doesn't use ALTERNATE or
RANDOMSIDES. 
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2.23 Save button

   Save button

Use this button to save and name the active drawing.  Fractal Lab displays the Save As dialog box
so you can name your drawing.  

To save a drawing with its existing name and directory, use the File/Save command.

2.24 Load button

   Load button

Use this button to open an existing data/image file in a new window.  Use the Window menu to
switch among open images, if maximized, or click on a draw window to make it the active window. 

2.25 Bmp radio button

   BMP radio button

Use this button to select the BMP format when loading and saving fractals.  This is the default
Windows bitmap format, readable by most Windows programs that use image files.  This is also the
fastest method of loading and saving fractals, but requires more disk space, since no compression is
used. Windows keeps track of the last six BMP files saved or loaded (displayed in the Files menu.) 

2.26 Png radio button

   PNG radio button

Use this button to select the PNG format when loading and saving fractals.  This format uses medium
compression without loss of image quality.

2.27 Jpg radio button

   JPG radio button

Use this button to select the JPEG format when loading and saving fractals.  This format uses
moderate compression but with some loss of image quality.  Preferable for posting to the net, since
most browsers can display jpeg files.

2.28 ||||| button

    ||||| button

Through a series of windows, this allows you to name and open an avi animation stream and choose
a compression method.  After choosing the frame rate (1-60 fps) and using the file requester to
name the file, you are given a choice of compression methods.  You can also choose no
compression for optimum view quality.  (Unless you are limited on disk space, it's best to create the
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video using no compression and save a copy of it later in compressed format  All compression
methods degrade the original images, some more than others.)  The first key frame in the stream is
then drawn and written to the file.

Note: after the stream is opened, the size of the fractal that can be drawn is fixed at the size of the
frame.  No changes can be made to the size until the stream is closed.

2.29 > button

    > button

With this option, frames are written to a stream based on the difference between the current key
frame and the previous key frame.  The first key frame is written when you open a stream.  The next
key frame is created each time you use this option.  In between you can zoom or change fractal
variables as much as necessary.  The stream is only written to when this option is used.  The last key
frame is automatically saved after the 'tween' series is written.  The number of frames may range
from 1-1500 frames between keys.  With a frame number of 1 only the key frames are written.  This
allows animation  to be created that incorporate all scalable variables in Fractal Lab.

Use the Cancel button to exit this dialog without initializing a new series of frames.

Check the Log Scaling box if you want the frames to be written with logarithmic space between
frames, else linear space is used.

2.30 [] button

    [ ] button

Closes any open avi stream file.  You need to do this before viewing the file or creating a new avi
file.  The stream is also closed when you exit Fractal Lab. 

2.31 V button

    V button

Opens an avi file for viewing.  You can preview any multimedia file by clicking on its file name.  A
multimedia box will appear to the right of the file list.  Click on okay to open the main view window.

There are buttons to Play a file forwards or Backwards, or forward automatically with Auto rewind/
repeat.  Click on Slow to slow down a video.  Each click on Slow halves the viewing speed.  A
click on Stop freezes viewing and restores the view speed to normal playback.

Use the Open button to view a different avi file.  Use the Save button to save the file in a different
compression format.  You must use a different name to save the file than the name that was used to
open it.  Click on the left-mouse button or any key to abort a save operation.
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3 File menu

  File menu commands

The File menu offers the following commands loading and saving drawings and exiting the program:

New Creates a new drawing.
Open     Opens an existing drawing.
Close     Closes an opened drawing.
Save Saves an opened drawing using the same file name.
Save As     Saves an opened drawing to a specified file name.
Load Parameters    Load parameters from an existing drawing.
Open [JPEG]    Load jpeg.
Open [PNG]    Load png.
Save  Parameters    Save parameters for an opened drawing to a specified file name.
Save As [JPEG]    Save in jpeg format.
Save As [PNG]    Save in png format.
Exit Exits Fractal Lab.

3.1 File Open[JPG] command

   Open [JPEG] command (File menu)

Use this command to load parameters and a bitmap file that were saved in jpeg format.  There is an
option in the file-type box to load only the bitmap too.  This replaces the Open command for those
who need a smaller sized bitmap file.  Note: the last files list in the File menu doesn't keep track of
images loaded in JPEG format.

3.2 File Save Bitmap As [JPG] command

   Save As [JPEG] command (File menu)

Use this command to save the parameters and active bitmap in jpeg format.  There is an option in
the file-type box to save only the bitmap too.  This replaces the Save and Save As command for
those who need a smaller sized bitmap file.  Note: the last files list in the File menu doesn't keep
track of images saved in JPEG format.

3.3 File Open [PNG] command

   Open [PNG] command (File menu)

Use this command to load parameters and a bitmap file that was saved in png format.  There is an
option in the file-type box to load only the bitmap too.  This replaces the Open command for those
who need a smaller sized bitmap file.  Note: the last files list in the File menu doesn't keep track of
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images loaded in PNG format.

3.4 File Save Bitmap As [PNG] command

   Save As [PNG] command (File menu)

Use this command to save the parameters and active bitmap in png format.  There is an option in the
file-type box to save only the bitmap too.  This replaces the Save and Save As command for those
who need a smaller sized bitmap file.  Note: the last files list in the File menu doesn't keep track of
images saved in PNG format.

3.5 File Load Parameters command

   Load Parameters command (File menu)

Use this command to load a data file [.frl].  The data file contains all variables to recreate an image
created previously with Fractal Lab.

3.6 File New command

   New command (File menu)

Use this command to create a new drawing window in Fractal Lab.  The image and data for the
opening picture are used to create the new window.

You can open an existing data/image file with the Open command.

Shortcuts
Keys: CTRL+N

3.7 File Open command

   Open command (File menu)

Use this command to open an existing data/image file in a new window.  You can open multiple
image files at once.  Use the Window menu to switch among the multiple open images.  See 
Window 1, 2, ... command.

You can create new images with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O
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3.8 AFX_HIDD_FILEOPEN

File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.  This box lists files with the extension you select in
the List Files of Type box. 

List Files of Type
Select the type of file you want to open:
<< List your application's file types here. >>

Drives
Select the drive in which Fractal Lab stores the file that you want to open. 

Directories
Select the directory in which Fractal Lab stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

3.9 File Close command

   Close command (File menu)

Use this command to close the window containing the active image.  If you close a window without
saving, you lose all changes made since the last time you saved it.

You can also close a drawing by using the Close icon on the drawing window, as shown below:

3.10 File Save command

   Save command (File menu)

Use this command to save the active drawing to its current name and directory.  When you save a
drawing for the first time, Fractal Lab displays the Save As dialog box so you can name your
drawing.  If you want to change the name and directory of an existing drawing before you save it,
choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S
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3.11 File Save As command

   Save As command (File menu)

Use this command to save and name the active drawing.  Fractal Lab displays the Save As dialog
box so you can name your drawing.  

To save a drawing with its existing name and directory, use the Save command.

3.12 AFX_HIDD_FILESAVE

File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a drawing with a different name.  A filename can contain up to eight
characters and an extension of up to three characters.  Fractal Lab adds the extension you
specify in the Save File As Type box.

Drives
Select the drive in which you want to store the drawing.

Directories
Select the directory in which you want to store the drawing.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

3.13 File 1, 2, 3, 4, 5, 6 command

   1, 2, 3, 4, 5, 6 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last six drawings
you closed.  Choose the number that corresponds with the drawing you want to open.

3.14 File Exit command

  Exit command (File menu)

Use this command to end your Fractal Lab session.  You can also use the Close command on the
application Control menu.  Note: if you choose to exit while plotting, the program does not
terminate, but stops the plotting so the program can be safely exited.

Shortcuts
Mouse: Double-click the application's Control menu button.
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Keys: ALT+F4

3.15 File Save Parameters command

   Save Parameters command (File menu)

Use this command to save all data elements for the current image in a data file [.frl].
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4 Edit menu

  Edit menu commands

The Edit menu offers the following commands for editing fractal parameters:

Undo Undo last edit, action or zoom.
Copy    Copy the active view and put it on the Clipboard.
Paste     Insert Clipboard contents.
Copy Data     Copy fractal data to buffer.
Paste Data     Copy data from copy buffer.
Generator  Edit generator.
Initiator  Edit initiator.
Size     Sets the image size.
Scale  Edit initiator scale.
Scale Composite  Edit initiator scale for composite figure.
Palette Editor Edit palette.
Text     Edit and add text to drawing.
Preferences    Default directories for saving and loading drawings and videos.

4.1 Edit Undo command

   Undo command (Edit menu)

Use this command to undo the last action.  An image can be continued after an undo, if continue was
enabled before the last action.  Color-cycling is disabled after using Undo, though. 
Undo is disabled for bitmaps whose width is not a multiple of 8. 

Shortcut
Keys: CTRL+Z

4.2 Edit Copy command

   Copy command (Edit menu)

Use this command to copy the active view to the clipboard.  The entire view is copied to the
clipboard.

Shortcut
Keys: CTRL+C

4.3 Edit Paste command

   Paste command (Edit menu)
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Use this command to paste from the clipboard.  The clipboard must contain a bitmap.  If the bitmap
is larger than the view, it is clipped.  The zoom cursor is used to set the left/top corner in the view
where the bitmap will be pasted.  Click outside the view frame or press escape to exit this option.

Shortcut
Keys: CTRL+V

4.4 Edit Copy Data command

   Copy Data command (Edit menu)

Use this command to copy the fractal data for the active view to the file "frlcopy.frl".  The current
palette for the view is also copied.

Shortcut
Keys: CTRL+F

4.5 Edit Paste Data command

   Paste Data command (Edit menu)

Use this command to paste the data in the file "frlcopy.frl" to the active view.  The palette stored in
the file is pasted also.

Shortcut
Keys: CTRL+R

4.6 Generator Window

   Generator Window

The Edit Generator window allows you to add and edit up to 100 segments for the fractal generator.
 The top row of boxes/buttons are the control boxes and the lower edit boxes are for entering data.

The Control boxes:
The # box is used to enter a number within the range of existing segments to insert or recall a
segment for changing or deleting.  You can also insert what you recall or add it back too.

The Add button adds a segment to the end of the list of generator segments.  You must first enter a
valid segment into the data boxes.

The Change and Delete buttons are enabled after "recalling" a segment, to edit or delete a previously
added or inserted segment.
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The Insert button works with the # box to add a segment in front of the previously added segment.

The Recall button enters a previously-added segment into the data boxes, to enable editing or
deleting it.  This prevents erasing or changing a segment, with the wrong number in the # box.  You
can also recall a segment with a click of the left mouse button when it is positioned over the
displayed segment.

The Cancel button cancels a recall operation and re-enables the # and Recall buttons.

The Data edit boxes:

The Direction box defines the direction of the segment relative to the 0 degree position, (-90 is
straight up), or full right.  The direction for a generator segment ranges from -180 to 180 (degrees).

The Length box defines the length of the segment as a fraction of the total length of the initiator
segment length.  This ranges from -1.0 to 1.0.  Enter a negative length if you want to move to a new
segment location, instead of drawing the line there.  This is useful for creating "island" fractals whose
segments are not necessarily continuous.  When you enter a negative length, also enter a direction
180 degrees from the direction you want to move, or the opposite direction (a move is computed as
a negative direction.) All fractional input is rounded to nine decimal places.  There are two shortcuts
you can use when entering lengths that simplify entering square roots and reciprocals.  Use 'i' with a
whole number for a reciprocal and 's' for a square root.  For example, enter 3i for "1/3" and 3s for
"square root of 3".

The Side box determines which side the generator will appear at the next recursion level subject to
the settings of the Flags menu, right (0) or left (1).

Choose the color of the segment by clicking on one of the 236 segments in the color bar.  The
current color is drawn  below the word Colors.  Index 0 is the same as the background color, so
use this to hide a segment.

4.7 Initiator Window

   Initiator Window

The Edit Initiator window is the editor for the fractal initiator.  It  has control buttons that work the
same as those with the generator editor, and different data boxes.  You can add or edit up to 100
segments for each initiator.

Use the Rotate button to rotate all the segments in the initiator by the degrees in the Direction box. 
Useful for creating smooth rotations in an animation (with one of the A/V "smooth rotation" options
selected.)  All segments are assumed to be connected, that is the end point of one segment is
connected to the starting point of the next segment.  Hint:  this allows you to add segments (identical
to the first segment) without computing their starting or ending points.  Just enter the correct
Direction for each additional segment before clicking on the rotate button.  Rotate 0 will connect all
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the segments.

The Data edit boxes:

The Direction box defines the direction of the initiator segment relative to 0 degrees, or straight up. 
Acceptable angles are 0 to 359 degrees.

The Length box defines the length of the segment in screen pixels.

The Side box controls which side the generator is placed initially, left (1) or right (0).  For a segment
going right 90 degrees, this would place the first generator upright.

The Left, Right, LeftBottom, RightBottom boxes set the start and end positions on screen for each
initiator segment.  The Right and Right Bottom coordinates are calculated automatically according to
the following formulas:

   Right = Left + Sine(degrees) * length
   RightBottom = LeftBottom - Cosine(degrees) * length

where degrees is the segment direction. These formulas are accurate plus or minus a pixel.  Under
some conditions, line misplacements will be noticed due to the limits of the floating point arithmetic
used in Fractal Lab.  You may want to experiment with the Directions and Lengths to get the most
accurate results.

Note: angles may appear a few degrees off on the finished fractal, if the screen pixel on your monitor
is not exactly square.  This shouldn't happen with a VGA monitor.  Relative space between lines
should still allow non-contacting fractals to remain non-contacting.

4.8 Size

    Size (Edit menu)

This allows you to set the drawing area for a picture, independent of the Windows screen size.  It
also shows which size is currently in use.  The aspect for the drawing is based on the ratio of X
(horizontal width) to Y (vertical height.)  The custom setting allows for any size/aspect that system
memory will permit.  The minimum size for an image is 60X30.  Note: the aspect of the figure drawn
is always 1/1 regardless of the drawing window aspect.

4.9 Scale

   Scale

Invokes the Scale window.  The Scale Window scales the initiator length and screen positions to
effectively reduce or expand the fractal image.  A scale of .5 affects both X and Y coordinates, so
the image is quartered.  A scale of 2.0 would make the image four times as large.  A range of .1 to
9.9 is allowed in the scale gadget, but the program checks that points do not exceed screen limits. 
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A fractal may still attempt to draw itself off screen, and is then clipped.  Points that would end off the
screen are not drawn.

4.10 Scale Composite

   Scale Composite

Invokes the Scale window to scale composite figures.  The Scale Window scales the initiator length
and screen positions to effectively reduce or expand the fractal image.  A scale of .5 affects both X
and Y coordinates, so the image is quartered.  A scale of 2.0 would make the image four times as
large.  A range of .1 to 9.9 is allowed in the scale gadget, but the program checks that points do not
exceed screen limits.  A fractal may still attempt to draw itself off screen, and is then clipped.  Points
that would end off the screen are not drawn.

4.11 Edit Palette

    Edit Palette

Use the palette editor to modify the color palette in use.  

Use the RGB-slider controls to edit any color in the palette.  Select Copy to copy any color to
another spot in the palette. Select Spread to define a smooth spread of colors from the current spot
to another spot in the palette.  Copy and Spread take effect immediately when you select another
spot with the mouse button.  You can cancel the operation with the Cancel button.  The Map button
is used to map color changes to an image after you are done adjusting the sliders.  In the HSV
mode, color spreads are based on HSV values instead of RGB values, which in some cases results
in brighter color spreads.

Right-click on any point on the main window and the palette color for that pixel will be displayed in
the palette editor.  You can use any of the color-cycling keys (after clicking on the main window) to
see the effects of the cycling in the palette editor window.   Note:  color cycling and color-selection-
from-pixel only works when the image has been drawn in the current session.  If you load a pre-
existing image file, you must redraw it to cycle colors, etc.  Undoing an action also disables color
cycling.

Use Reset to reset the colors of the palette to where it was before it was cycled or modified.

Use Reverse to reverse the order of the colors in the palette.  This affects only those colors in the
start-color to end-color range.

Use Neg to create a palette that is the complement of the current palette.

Use SRG to switch the red and green components of all palette colors.
Use SRB to switch the red and blue components of all palette colors.  SRB and SRG are disabled in
HSV mode.  You can use these buttons to form eight different palettes by repeatedly switching red,
green and blue components.
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Use the Random palette buttons to randomize the current palette.  Use Smooth to create a random
palette that has continuous color spreads between indexes.  Use Scramble to create a palette where
each index is unrelated to the next.  The Randomize variables, rmin, rmax, bmin, bmax, gmin, and
gmax act as limits that are applied after the palette after initial randomizing, to make the palette
conform to the desired spectrum of colors.

Note: unless you click on Reset before exiting the editor, changes are permanent to the palette, no
matter which way you close the editor (Okay button or close box.)

4.11.1 Red Slider

    Red slider
Use the RGB/HSV-slider controls to edit any color in the palette.

4.11.2 Green Slider

    Green slider
Use the RGB/HSV-slider controls to edit any color in the palette.

4.11.3 Blue Slider

    Blue slider
Use the RGB/HSV-slider controls to edit any color in the palette.

4.11.4 Reset Button

    Reset button
Use Reset to reset the colors of the palette in use, to where it was before it was cycled or modified.
Note: if you change palettes with one of the function keys, any modifications to a previous palette
are unaffected by the Reset button.

4.11.5 Red edit box

    Red edit box
Shows red/hue value of selected color index.

4.11.6 Green edit box

    Green edit box
Shows green/saturation value of selected color index.

4.11.7 Blue edit box

    Blue edit box
Shows blue/value magnitude of selected color index.
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4.11.8 Cancel Button

    Cancel button
You can cancel a copy or spread operation with the Cancel button.

4.11.9 Okay Button

    Okay button
Click on Okay to exit the palette editor, applying unmapped color changes to picture (if color-
cycling is enabled.)

4.11.10 Spread Button

    Spread button
Select Spread to define a smooth spread of colors from the current spot to another spot in the
palette.

4.11.11 Copy Button

    Copy button
Select Copy to copy any color to another spot in the palette.

4.11.12 Neg Button

    Neg button
Use Neg to create a palette that is the complement of the current palette.

4.11.13 H/R Button

    H/R button
Change from HSV to RGB mode or back.  In the HSV mode, color spreads are based on HSV
values instead of RGB values, which in some cases results in brighter color spreads.

4.11.14 Rand Button

    Smooth palette button
Use to create a smooth random palette.  Color spreads move continuously from one color index to
the next.

4.11.15 Scramble Button

    Scramble palette button
Use to create a scrambled random palette.  Color spreads are discontinuous from one color index to
the next.

4.11.16 SRB Button

    SRB button
Use SRG to switch the red and blue components of all palette colors.  RGB mode only.
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4.11.17 SRG Button

    SRG button
Use SRG to switch the red and green components of all palette colors.  RGB mode only.

4.11.18 Map Button

    Map button
The Map button is used to map color changes to an image after you are done adjusting the sliders.

4.11.19 Reverse button

    Reverse button
Use Reverse to reverse the order of the colors in the palette.

4.11.20 Help Button

    Help button
Opens the help topic for the Palette editor.

4.11.21 Randomize variables

    Randomize variables
The Randomize variables, rmin, rmax, bmin, bmax, gmin, and gmax act as limits that are applied
after the palette after initial randomizing, to make the palette conform to the desired spectrum of
colors.

4.12 Edit Text command

    Text (Edit menu)

Allows you to edit text and font and apply it to a drawing.  Select the font button to set the font style,
size and color.  In the text window click on Okay to add a line of text to the current image.  (You
can add multiple lines of text too, up to 80 characters.)  The cursor will change to a crosshair. 
Position the cursor where you want the text to start and left-click the mouse.  Note: font and text are
saved in the file "prefs.txt" in Fractal Lab's startup directory.

4.13 Preferences

    Preferences (Edit menu)

Use this option to view or change the default directories for saving and loading drawings and videos.
 Note: when you change directories and save a drawing in a directory different from the default
directory, that directory becomes the default directory.  Usually you won't have to change the default
directory through the Preferences window unless the default directory is inaccessible for some
reason.  This could happen if you save a drawing in another computer, as in a home network, and
the computer is not powered on at the next session.
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5 Image menu

   Image menu commands

The Image menu offers the following commands for plotting and processing images:

Draw Draw the picture.
Draw Composite Draw composite figures.
Auto Redraw    Redraw image on command.
Auto Clear     Clear drawing area before new plot.
Auto Sound Alert    Enable or turn off sound alerts.
Auto Remote Open remote automatically at startup.
Auto Time   Show time used to plot image.
Merge Sum     Merge current pixel color with previous color summing colors.
Merge And     Merge current pixel color with previous color anding colors.
Merge Or     Merge current pixel color with previous color oring colors.
Merge High     Merge current pixel color with previous color by choosing highest rgb.
Merge Low     Merge current pixel color with previous color by choosing lowest rgb.
Merge Back     Merge current pixel color with previous color by excluding background
color.
Merge Diff     Merge current pixel color with previous color by using difference of colors.

Abort     Abort drawing.
Move     Move figure with mouse.
Move Composite    Move composite figure with mouse.
Center     Center figure.
Center Composite    Center composite figure
Reset     Reset Generator and Initiator for current view.
Clear     Erase active drawing window.
Cycle Colors    Cycle colors.
Full Screen     View image full-screen.
Figure 1-10     Switch to figure # (1-10).
Composite  Select figures to merge.
Calculate Fractal Dimension   Calculate fractal dimension of a figure using  "box" method

5.1 Image Draw command

   Draw command (Image menu)

Use this command to draw or redraw the image for the current fractal variables.  "Draw" invokes the
Level window, then draws the current fractal at the specified level of recursion.  Clears the screen
before drawing (if autoclear is enabled).  Click the left-mouse button to stop a drawing in progress. 
Select Draw to draw a new fractal, with a new random factor if the RANDOMSIDES flag is set. 
Select Redraw to keep the current random factor.  Note: the current random factor may not
produce the same image pattern if the depth of the picture is changed.
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5.2 Image Draw Composite command

   Draw Composite command (Image menu)

Use this command to draw or redraw an image defined in the Image/Composite command as a
merging of figures 1-10.  Clicking inside the draw window with the left-mouse button stops all
plotting.  

5.3 Image Redraw command

   Auto Redraw command (Image menu)

With this command disabled (on by default), redraw does not occur except when the Draw
command is executed.  Most of the time you want to see the results of changing a parameter or
mapping option, so redraw occurs automatically with parameter or mapping changes.  Sometimes
you want to change more than one parameter before redrawing the image.  So you might need to
turn this option off then to avoid drawing off screen, etc.

5.4 Image Auto Clear command

   Auto Clear command (Image menu)

With this command enabled (on by default), the drawing area is cleared before starting a new plot. 
You can turn off this option when you want to see the effect of minor changes to parameters, as they
affect the plot pixel by pixel, or when setting up a multiple-layered fractal.  You can use the shift-c
command (hot keys) to clear the drawing area at any time.

5.5 Image Auto Alert command

   Auto Sound Alert command (Image menu)

With this command enabled (on by default), the user is notified by a sound clip when a drawing is
completed or user-canceled.  By disabling this command the completion exclamation is suppressed
and also any alert that contains a message box.  Note: some sound clips are automatically generated
by Windows, or there is no text alert for a given error condition.  In these cases the sound alert is
unaffected by the Auto Alert command.

5.6 Image Auto Remote command

   Auto Remote command (Image menu)

With this command enabled (on by default), the remote is opened immediately at program startup. 
Handy if you find the remote useful and don't want to click on the toolbar button each time the
program starts up.
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5.7 Image Auto Time command

   Auto Time command (Image menu)

With this command enabled (on by default), the time that an image takes to plot is displayed when
the plot is complete.  Fractal Lab saves the condition of this option at session's end, so if you disable
it and close the program, the option will be disabled when you restart Fractal Lab.

5.8 Image Merge Sum command

   Merge Sum command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a new image
is drawn.  Instead the colors are merged using a summing algorithm.  The auto-clear option must be
disabled and solid-guessing off to choose this option.  Useful to merge two or more separate fractal
images/types with the initial image(s) "bleeding" through.

5.9 Image Merge And command

   Merge And command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a new image
is drawn.  Instead the colors are merged using an anding algorithm.  The auto-clear option must be
disabled and solid-guessing off to choose this option.  Useful to merge two or more separate fractal
images/types with the initial image(s) "bleeding" through.

5.10 Image Merge Or command

   Merge Or command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a new image
is drawn.  Instead the colors are merged using an oring algorithm.  The auto-clear option must be
disabled and solid-guessing off to choose this option.  Useful to merge two or more separate fractal
images/types with the initial image(s) "bleeding" through.

5.11 Image Merge High command

   Merge High command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a new image
is drawn.  Instead the colors are merged using the highest rgb values of both images.  The auto-clear
option must be disabled and solid-guessing off to choose this option.  Useful to merge two or more
separate fractal images/types with the initial image(s) "bleeding" through.

5.12 Image Merge Low command

   Merge Low command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a new image
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is drawn. Instead the colors are merged using the lowest rgb values of both images.  The auto-clear
option must be disabled and solid-guessing off to choose this option.  Useful to merge two or more
separate fractal images/types with the initial image(s) "bleeding" through.

5.13 Image Merge Back command

   Merge Back command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a new image
is drawn. Instead the colors are merged using the rgb components of the new image if the new color
index is not zero; else the old rgb values are retained.  The auto-clear option must be disabled and
solid-guessing off to choose this option.  Useful to merge two or more separate fractal images/types
with the initial image(s) "bleeding" through.

5.14 Image Merge Diff command

   Merge Diff command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a new image
is drawn. Instead the colors are merged using the difference of the rgb values of both images.  The
auto-clear option must be disabled and solid-guessing off to choose this option.  Useful to merge
two or more separate fractal images/types with the initial image(s) "bleeding" through.

5.15 Image Abort command

   Abort command (Image menu)

Use this command to stop drawing.  Clicking inside a window's drawing area or close box (or the
program close box) will also stop the drawing.  Note: once a plot has started Fractal Lab continues
to draw the image for that window regardless of which drawing window has the input focus, until
done or aborted.  You can open and close other drawing windows without affecting the current
drawing, but only one drawing is active at any time. 

5.16 Move

   Move

"Move" changes the cursor to a cross to relocate the fractal's starting point anywhere on the screen,
modifying the setting of the initiator  Click where you want the center of the fractal.  The starting
points of each initiator segment are adjusted to correspond with the shift in the first segment.  Useful
for tiling multiple fractals on the screen, or putting different fractals side by side.  Does not change
the random factor when the RANDOMSIDES flag is set.  This enables random dragons to be
moved.

5.17 Move Composite

   Move Composite
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"Move Composite" changes the cursor to a cross to relocate the fractal's starting point anywhere on
the screen, modifying the setting of all the initiators in a composite fractal.  Click where you want the
center of the composite fractal.  The starting points of each initiator segment are adjusted to
correspond with the shift in the first segment.  Useful for tiling composite fractals on the screen, or
putting different fractals side by side.  Does not change the random factor when the
RANDOMSIDES flag is set.  This enables random dragons to be moved.

5.18 Center

   Center

Use this command to re-center the current figure.  Useful when you rotate a figure and it ends up off
center.

5.19 Center Composite

   Center Composite

Use this command to re-center all figures in the current composite figure.  Useful when you rotate a
figure and it ends up off center.  Note: each figure can have a different center point, so using this
command won't necessarily make all figures line up around the same center point.  Use Move
Composite to change the center point for all figures to the same point.

5.20 Reset

    Reset

"Reset" erases the current generator and initiator from memory.  The screen is not cleared or
otherwise affected. 

5.21 Color Cycle command

   Cycle command (Color menu)

Use this command to cycle colors when not plotting.  Undoing an action disables the cycle command
until the image is redrawn.

5.22 Clear

    Clear

The active draw window is erased and set to color index 0, the background color. 

5.23 Full Screen

    Full Screen (Image menu)

Displays the entire plot, expanding or shrinking the image to fit in a maximized window without title
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bar, scroll bars or menu bar.  At all other times, part of the picture may be hidden by the inclusion of

the title bar, toolbar, scroll bars and menu bar.  To exit full-screen mode, press any key or click the
left-mouse button.

5.24 Figure #

    Figure #

Switch to Figure # (1-10).  Current settings are saved under the previous image. Fractal Lab
supports up to 10 figures in the same data file.  You can combine these figures into one image using
the Image/Draw Composite and Image/Composite commands.

5.25 Image Composite command

   Composite command (Image menu)

Opens the Composite Figure window, where you can define a set of figures to merge into one
image.  All the merging options in the Merge Color menu are supported, plus "ALL" which is usually
used for the first figure to be drawn.  The "ALL" option transfers all rgb information for a figure to
the drawing area, without checking the rgb state of the pixel.  You can define up to ten figures
(layers), as part of the composite, but each figure should contain an image (if used in the composite.)

5.26 Calculate Fractal Dimension

   Calculate Fractal Dimension

This routine calculates the fractal dimension of a figure using the Barnsley's "box" method.  The
formula is log(N)/Log(m), where N = 2 and 'm' is the magnification factor.  For maximum accuracy,
the background color should be composed entirely of color index  #1, and the figure should not
contain any pixels colored with the background color.
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6 Flags menu

  Flags menu commands

The Flags menu offers the following commands for positioning the generator during plotting:

ALTERNATE Alternate generator at every level.
RANDOMSIDES Random generator sides
RANDOMREVERSE Random reverse generator.
ALTFIRSTPOS Alternate generator at every other level.
REVRIGHTSIDE Reverse generator on right side.
NO FLAGS Clear all flags.

6.1 Alternate

   Alternate

ALTERNATE tells the generate routine to reverse the side placement of the generator at each stage
of recursion.  Must be set to draw snowflakes, etc.  ALTERNATE excludes the RANDOMSIDES
and ALTFIRSTPOS flags and enables the RANDOMREVERSE flag to be set or not.

6.2 Random Sides

   Random Sides

RANDOMSIDES randomizes the side the generator is placed on at the first stage of each level of
recursion after the first recursion.  Must be set to draw random dragons.  Excludes ALTERNATE,
ALTFIRSTPOS and disables the RANDOMREVERSE item.

6.3 Random Reverse

   Random Reverse

RANDOMREVERSE reverses the generator without changing the side it is to be draw on.  Used to
create random snowflakes, etc.

6.4 AltFirstPos

   AltFirstPos

ALTFIRSTPOS alternates the generator every other level starting with the lowest level.  Excludes
ALTERNATE and RANDOMSIDES.  Used for the Polya fractal.
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6.5 RevRightSide

   RevRightSide

REVRIGHTSIDE reverses the generator when it is drawn on the right side.  Used for the Peano-
Gosper fractal and Quartet fractal. Can be used with any of the other flags, for different effects.

6.6 No Flags

   No Flags

NO FLAGS excludes all other flags and disables RANDOMREVERSE.  Use to display the original
dragon curve, or to eliminate the random factor from any curve that doesn't use ALTERNATE or
RANDOMSIDES. 
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7 View menu

  View menu commands

The View menu offers the following commands:

Toolbar   Shows or hides the toolbar.
Status Bar      Shows or hides the status bar. 

7.1 View Toolbar command

  Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most
common commands in Fractal Lab, such as File Open.  A check mark appears next to the menu
item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.

7.1.1 toolbar

  Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.  The toolbar
provides quick mouse access to many tools used in Fractal Lab,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open the Remote which contains shortcut buttons for many common tasks and options
in Fractal Lab

Open a new drawing window in Fractal Lab.

Open an existing drawing.  Fractal Lab displays the Open dialog box, in which you can
locate and open the desired file.

Save the active drawing or template with a new name.  Fractal Lab displays the Save As
dialog box.

Set image size.

Edit palette.

Edit the current figure's generator.

Edit the current figure's initiator.

Draw image from current parameters.

Show picture full-screen.
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Display info about Fractal Lab.

7.2 View Status Bar Command

 Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by
the selected menu item or depressed toolbar button, and keyboard latch state. A check mark
appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.

7.2.1 status bar

 Status Bar

The status bar is displayed at the bottom of the Fractal Lab window.  To display or hide the status
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate
through menus.  This area similarly shows messages that describe the actions of toolbar buttons as
you depress them, before releasing them.  If after viewing the description of the toolbar button
command you wish not to execute the command, then release the mouse button while the pointer is
off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.
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8 Window menu

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple images in
the application window:

Cascade   Arranges windows in an overlapped fashion.
Tile     Arranges windows in non-overlapped tiles.
Arrange Icons     Arranges icons of closed windows.
Size Desktop     Size drawing area to window frame.
Window 1, 2, ...       Goes to specified window.

8.1 Cascade

Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 

8.2 Tile

Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.

8.3 Arrange

Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.  If
there is an open drawing window at the bottom of the main window, then some or all of the icons
may not be visible because they will be underneath this drawing window. 

8.4 Size DeskTop

Window Size DeskTop Command

Use this command to size the active drawing window to its frame size.  Use after Tile command to
reduce white space around a drawing that is smaller than screen size.

8.5 1, 2, ...

1, 2, ... command (Window menu)
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Fractal Lab displays a list of currently open drawing windows at the bottom of the Window menu. 
A check mark appears in front of the drawing name of the active window.  Choose a drawing from
this list to make its window active.  
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9 A/V menu

  A/V menu commands

The A/V menu offers the following commands for creating and viewing AVI videos:

Open AVI Stream Open AVI file for writing and draw initial frame.
Write Frames Write frames to AVI file.
Close AVI Stream  Close an existing AVI stream.
View AVI  View an AVI animation file.
AVI Composite  Generate composite video.
Clockwise  Rotate in clockwise direction.
Counter-Clockwise Rotate in counter-clockwise direction.

9.1 Open Avi Stream

    Open Avi Stream…

Through a series of windows, this allows you to name and open an avi animation stream and choose
a compression method.  After choosing the frame rate (1-60 fps) and using the file requester to
name the file, you are given a choice of compression methods.  You can also choose no
compression for optimum view quality.  (Unless you are limited on disk space, it's best to create the
video using no compression and save a copy of it later in compressed format  All compression
methods degrade the original images, some more than others.)  The first key frame in the stream is
then drawn and written to the file.

Note: after the stream is opened, the size of the fractal that can be drawn is fixed at the size of the
frame.  No changes can be made to the size until the stream is closed.

9.2 Write Frames

    Write Frames…

With this option, frames are written to a stream based on the difference between the current key
frame and the previous key frame.  The first key frame is written when you open a stream.  The next
key frame is created each time you use this option.  In between you can zoom or change Avi
variables as much as necessary.  The stream is only written to when this option is used.  The last key
frame is automatically saved after the 'tween' series is written.  The number of frames may range
from 1-1500 frames between keys.  With a frame number of 1 only the key frames are written.  This
allows animation to be created that incorporates all scalable variables in Fractal Lab.

Use the Cancel button to exit this dialog without initializing a new series of frames.

Check the Log Scaling box if you want the frames to be written with logarithmic space between
frames, else linear space is used.
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Notes: key frames are saved in parameter files (frl), with filenames of "bvf_image#_title.frl", where
'#' is the number of the keyframe and 'title' is the name of the working fractal file.  

9.3 Close Avi Stream

    Close Avi Stream

Closes any open avi stream file.  You need to do this before viewing the file or creating a new avi
file.  The stream is also closed when you exit Fractal Lab. 

9.4 View Avi

    View Avi…

Opens an avi file for viewing.  You can preview any multimedia file by clicking on its file name.  A
multimedia box will appear to the right of the file list.  Click on okay to open the main view window.

There are buttons to Play a file forwards or Backwards, or forward automatically with Auto rewind/
repeat.  Click on Slow to slow down a video.  Each click on Slow halves the viewing speed.  A
click on Stop freezes viewing and restores the view speed to normal playback.

Use the Open button to view a different avi file.  Use the Save button to save the file in a different
compression format.  You must use a different name to save the file than the name that was used to
open it.  Click on the left-mouse button or any key to abort a save operation.

9.5 Avi Composite

    AVI Composite

When this flag is set, Fractal Lab generates composite figures for a video according to the settings in
the Image/Composite window.  Each frame may then consist of a merging of up to 4 figures (1-4). 
You must set this flag and the composite options before beginning a video.  After an avi stream has
been opened, you can then use variations of any figure in the composite to produce tweens while
using the Write Frames option.  As usual, you vary data in the figure(s) before writing frames. 

9.6 Rotations -> Clockwise

    Rotations -> Clockwise

Select this when you want a figure to rotate clockwise (after rotating the initiator by n degrees.)

9.7 Rotations -> Counter-clockwise

    Rotations -> Counter-clockwise

Select this when you want a figure to rotate counter-clockwise (after rotating the initiator by n
degrees.)
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10 Demo menu

  Demo menu commands

The Demo menu offers the following commands, which illustrate various features of Fractal Lab:

Snowflake     Generate random or original snowflake curve.
Snowflake 13    Generate random or original 13-segment snowflake curve.
Monkey     Generate random or original monkey curve.
Koch     Generate random or original Koch curve.
Quadric Koch    Generate random or original Quadric Koch curve.
Quartet Koch    Generate random or original Quartet Koch curve.
Cesaro     Generate random or original Cesaro curve.
Fudgeflake     Generate random or original fudgeflake curve.
Gosper     Generate random or original Peano-Gosper curve.
Dragon     Generate random or original dragon curve.
Sierpinski Gasket    Generate random or original Sierpinski Gasket.
Sierpinski Carpet    Generate random or original Sierpinski Carpet.
Polya Sweep    Generate random or original Polya Sweep.
Original Curves Only Demo original curves only.
Random Curves   Demo random curves.

10.1 Snowflake

    Snowflake (Demo menu)

A snowflake curve is generated, either random or original, depending on the demo option chosen. 

10.2 Snowflake 13

    Snowflake 13 (Demo menu)

A 13-segment snowflake curve is generated, either random or original, depending on the demo
option chosen. 

10.3 Monkey

    Monkey (Demo menu)

A monkey snowflake curve is generated, either random or original, depending on the demo option
chosen. 

10.4 Koch

    Koch (Demo menu)
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A Koch curve is generated, either random or original, depending on the demo option chosen. 

10.5 Quadric Koch

    Quadric Koch (Demo menu)

A Quadric Koch curve is generated, either random or original, depending on the demo option
chosen. 

10.6 Quartet Koch

    Quartet Koch (Demo menu)

A Quartet Koch curve is generated, either random or original, depending on the demo option
chosen. 

10.7 Cesaro

    Cesaro (Demo menu)

A Cesaro curve is generated, either random or original, depending on the demo option chosen. 

10.8 Fudgeflake

    Fudgeflake (Demo menu)

A fudgeflake curve is generated, either random or original, depending on the demo option chosen. 

10.9 Gosper

    Gosper (Demo menu)

A Peano-Gosper curve is generated, either random or original, depending on the demo option
chosen. 

10.10 Dragon

    Dragon (Demo menu)

A dragon curve is generated, either random or original, depending on the demo option chosen. 

10.11 Sierpinski gasket

    Sierpinski Gasket (Demo menu)

A Sierpinski gasket is generated, either random or original, depending on the demo option chosen. 
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10.12 Sierpinski carpet

    Sierpinski Carpet (Demo menu)

A Sierpinski carpet is generated, either random or original, depending on the demo option chosen. 

10.13 Polya sweep

    Polya Sweep (Demo menu)

A Polya sweep curve is generated, either random or original, depending on the demo option
chosen. 

10.14 Original Curves only

    Original Curves only (Demo menu)

The original curve is drawn for each demo figure. 

10.15 Random curves

    Random Curves (Demo menu)

A random curve is drawn for each demo figure, using the RANDOMSIDES and REVRIGHTSIDE
flags. 
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11 Help menu

  Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Getting Started     Tutorial for new users of Fractal Lab.
Index      Offers you an index to topics on which you can get help.
Hot Keys      Quick reference to Fractal Lab's hot keys.
Bibliography      Sources for fractal information and complex numbers.
About Fractal Lab     Displays the version number and author info for this application.

11.1 Getting Started

    Getting Started

Welcome to Fractal Lab!

For help on any menu command, press F1 while the command is highlighted.  For help on the
Generator or Initiator windows, click on the Help button inside those windows.

Many examples of the kinds of fractals that can be created in Fractal Lab are included in the Demo
menu.  Select one of the fractal types like Snowflake, and Fractal Lab will draw it for you, either
with a random twist (the default setting) or the original curve.  To increase the resolution of a fractal,
select the Remote's Draw button or menu command Image/Draw (or the toolbar draw button) and
increase the “Level of recursion” in the Drawing Level box.  Use “redraw” to maintain the current
random factor.

You can study how it is created by scanning the generator and initiator lists in their respective
windows.  To see the fractal as it originally appeared in Mandelbrot's The Fractal Geometry of
Nature, select the “Original Curves only” option in the Demo menu.  To follow along with
Mandelbrot's text, it helps to have a protractor and ruler, to measure lengths and angles of the
fractal's generator.  Mandelbrot provides mostly visual clues to how the Koch curves are generated,
and does not always include the exact angles or lengths of the generator.  Hint: if you see  “r = 1/3”
in the generator's illustration, that is the same as the generator's average “length” in Fractal Lab.  In
this case, start with .3333333 for a segment length and adjust each segment's length in the generator
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according to its length relative to other segments in the generator. If a segment is twice as long as the
average length, try using .666667 for that segment's length.  

All of the lengths or directions for a fractal generator usually have exact measurements to reproduce
the original fractal, but they can be changed for special effects or animations.  Try playing with the
Flags menu to create variations of the example fractals and any others you might create.  One of the
most interesting of the sample fractals to randomize is the Dragon fractal.

Fractal Lab allows you to Undo the last command in most cases.

Be sure to read the Generator and Initiator sections and the hot keys section for additional info.
The Bibliography lists additional reference material for a better understanding of the fractal types
and functions contained in Fractal Lab.

11.2 Index

Index command (Help menu)

Use this command to display the opening screen of Help.  From the opening screen, you can jump
to step-by-step instructions for using Fractal Lab and various types of reference information.  

Once you open Help, you can click the Contents button whenever you want to return to the opening
screen.

11.3 Hot Keys

    Hot keys

Shift-C -- clear the screen to the current background color.

Shift-T -- annotate a picture with text.  Cursor changes to a crosshatch, which you position over the
area where you want the text to start.  Then click the left-mouse button to transfer any text (from the
Edit/Text window) to the picture.  Can be used with Undo.  Use the Edit/Text command to change
font, text color or format text into multiple lines.  This is useful for adding copyright/author info to a
finished picture.

11.4 Bibliography

    Bibliography
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Illinois, 1975.
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11.5 About Fractal Lab

    About Fractal Lab

>>>>> Fractal Lab 1.03, ©1991-2010 by Terry W. Gintz <<<<<
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The original Fractal Lab was designed on an Amiga 2000 in 1989.

The science of Fractals was formally introduced by Benoit Mendelbrot in The Fractal Geometry of
Nature.  While being very descriptive of various recursive fractal curves, such as the Koch and
Peano curves, this book says very little on the art of generating such curves with a computer. 
Fractal Lab was written to enable a generalized creation of what Mandelbrot terms self-similar and
self-contacting/non-contacting recursive curves.  Most of the “uniform” curves appearing in The
Fractal Geometry of Nature can be produced using Fractal Lab.  And these can be done in color,
using a 236 color palette (out of 16 million possible colors.)  Mandelbrot illustrated these only in
black, white and gray scale.  No attempt is made to draw the Mandelbrot set or other complex-
number sets.  Fractal landscapes and scaling fractals (such as trees) are also outside the scope of
this program.

Mandelbrot uses the terms "generator" and "initiator" to describe the basic building blocks of self-
similar curves.  The generator describes the way a curve is broken down into smaller images of itself.
 The initiator describes how the generator is used.  The generator for a Koch curve would resemble
a line split into three sections, the middle section being replaced with the upper two legs of a
equilateral triangle.  The initiator would be a triangle to form a "Koch island".  There are various rules
for randomizing the generator and placement of the generator.  These will be explained in the menu
command descriptions.

Fractal Lab does more than emulate parts of The Fractal Geometry of Nature, because it allows one
to generate other curves not shown there, with up to 100 generator and initiator segments. At the
higher levels of recursion, some of these curves take on three-dimensional qualities like molecular
models.

Fractal Lab requires a true-color or high-color (16-bit) video adapter for best results.

For a short history of the programs that led up to the current version of Fractal Lab, see Chronology.

11.5.1 Chronology

   Chronology

In September 1989, I first had the idea for a fractal program that allowed plotting all complex
functions and formulas while attending a course on College Algebra at Lane College in Eugene,
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Oregon.  In November 1989, ZPlot 1.0 was done.  This Amiga program supported up to 32 colors,
640X400 resolution, and included about 30 built-in formulas and a simple formula parser.

May 1990 -- ZPlot 1.3d -- added 3D projections for all formulas in the form of height fields.

May 1991 -- ZPlot 2.0 -- first 236-color version of ZPlot for Windows 3.0.  (Fractal Lab was also
ported to Windows, along with a few other fractal programs)

May 1995 -- ZPlot 3.1 -- ZPlot for Windows 3.1 -- 60 built-in formulas.  Added hypercomplex
support for most built-in formulas.

May 1997 -- ZPlot 24.02 -- first true color version of ZPlot --  91 built-in formulas.  Included
support for 3D quaternion plots, Fractint  par/frm files, Steve Ferguson's filters, anti-aliasing and
Paul Carlson's orbit-trap routines.

June 1997 -- ZPlot 24.03 -- added Earl Hinrichs Torus method.

July 1997 -- ZPlot 24.08 -- added HSV filtering.

December 1997 -- Fractal Elite 1.14  --  100 built-in formulas; added avi and midi support.  Name
change due to trademark issues.

March 1998 --Split Fractal Elite into two programs, Dreamer and Medusa(multimedia.)

April 1998 -- Dofo 1.0 – (unreleased version) supports new Ferguson/Gintz plug-in spec.

June 1998 -- Dofo-Zon –(unreleased version) redesigned multi-window interface by Steve
Ferguson, and includes Steve's 2D coloring methods.

August 1998 --Dofo-Zon Elite -- combination of Fractal Elite and Dofo-Zon

October 1998 -- Dofo-Zon Elite v1.07 -- added orbital fractals and IFS slide show.

November 1998 -- Dofo-Zon Elite v1.08 -- added lsystems. 

April 1999 -- Split Dofo-Zon Elite into two programs: Fractal Zplot v1.15 using built-in formulas
and rendering methods, and Dofo-Zon (unreleased version) to support only plug-in formulas and
rendering methods.  (Dofo-Zon was later abandoned in favor of the original Dofo-Zon Elite.  Last
freeware version of DZE : May 2002 v1.22)

May 1999 -- Fractal Zplot 1.18 --  added Phong highlights, color-formula mapping and random
fractal methods.

June 1999 -- completed Fractal ViZion -- first version with automatic selection of variables/options
for all fractal types.

July 1999 -- Fractal Zplot 1.19 -- added cubic Mandelbrot support to quaternion option; first pc
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fractal program to render true 3D Mandelbrots.

September 2000 -- Fractal Zplot 1.22 -- added support for full-screen AVI video, and extended
quaternion design options.

October 2000 -- QuaSZ (Quaternion System Z) 1.00 -- stand alone quaternion/hypernion/cubic
Mandelbrot generator

November 2000 -- Added octonion fractals to QuaSZ 1.01.

March 2001 -- Cubics 1.0 -- my first totally-3D fractal generator.

May 2001 -- QuaSZ 1.03 -- added Perlin noise and improved texture mapping so texture tracks
with animations.

June 2001 -- Fractal Zplot 1.23 -- added Perlin noise and quat-trap method.

July 2001 -- QuaSZ 1.05 -- improved performance by converting many often-used dialogs to non-
modal type.

October 2001 -- FraSZle 1.0, QuaSZ formula and algebra compatible version of Fractal Zplot

November 2001 -- DynaMaSZ 1.0, the world's first Dynamic Matrix Systems fractal generator

January 2002 -- MiSZle 1.1 -- generalized fractal generator with matrix algebra extensions

May 2002 -- DynaMaSZ  SE 1.04 (unreleased version)-- scientific edition of DMZ, includes
support for user-variable matrix dimensions (3X3 to 12X12)

January 2003 -- Pod ME 1.0 -- first stand-alone 3-D loxodromic generator, Hydra 1.0 -- first 3-D
generator with user-defined quad types and Fractal Projector a Fractal ViZion-like version of DMZ
SE limited to 3X3 matrices

May 2003 -- FraSZle and Fractal Zplot 3.052 -- added random 3D orbital fractals, new 3D export
methods, upgraded most frequently-used dialogs to non-modal type and added genetic-style
function type.  FZ now based on FraSZle except for built-in formula list and Newton support.
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Index
- B -
button: [ ]     13

button: |||||     12

button: >     13

button: bmp     12

button: color     8

button: draw     9

button: generator     9

button: help     9

button: initiator     9

button: jpg     12

button: load     12

button: new     8

button: png     12

button: save     12

button: size     8

button: text     8

button: undo     8

button: V     13

button: view     9

- C -
color: blue edit box     26

color: blue slider     26

color: cancel button     27

color: copy button     27

color: edit palette     25

color: green edit box     26

color: green slider     26

color: h/r button     27

color: help button     28

color: map button     28

color: neg button     27

color: okay button     27

color: pixel     34

color: rand button     27

color: randomize variables     28

color: red edit box     26

color: red slider     26

color: reset button     26

color: reverse button     28

color: scramble button     27

color: spread button     27

color: srb button     27

color: srg button     28

- D -
demo: cesaro     50

demo: dragon     50

demo: fudgeflake     50

demo: gosper     50

demo: koch     49

demo: monkey     49

demo: original curves only     51

demo: polya sweep     51

demo: quadrickoch     50

demo: quartet koch     50

demo: random curves     51

demo: sierpinski carper     51

demo: sierpinski gasket     50

demo: snowflake     49

demo: snowflake 13     49

- E -
edit: copy     21

edit: copydata     22

edit: paste     21

edit: pastedata     22

edit: preferences     28

edit: size     24

edit: text     28

edit: undo     21

exit     18

- F -
files: load jpeg     15

files: load parameters     16

files: load png     15

files: managing     16, 17, 18

files: save parameters     19

files: write jpeg     15

files: write png     16
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- H -
help: about Fractal Lab     55

help: bibliography     54

help: chronololgy     56

help: hot keys     54

help: remote     8

help: tutorial     53

- I -
image: abort     33

image: auto alert     31

image: auto remote     31

image: auto time     32

image: clear     31, 34

image: composite     35

image: draw     30

image: draw composite     31

image: figure     35

image: merge and     32

image: merge back     33

image: merge diff     33

image: merge high     32

image: merge low     32

image: merge or     32

image: merge sum     32

image: redraw     31

image: reset     34

image: show picture     34

- S -
status bar     41

- T -
toolbar     40

- V -
video: avi composite     47

video: close avi stream     47

video: open avi stream     46

video: smooth rotations -> clockwise     47

video: smooth rotations -> counter-clockwise     47

video: view avi     47

video: write frames     46
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